Installing and Configuring Netbeans with XDebug

You could always just use Notepad++ as a text editor to create PHP programs, and in fact, I have done that with success for simple, stand-alone programs.

However, if you are working on a complex program using Object-Oriented-Programming (OOP) with multiple layers and interactions, using an Integrated Development Environment (IDE) with debugging capability (Step-Through, Breakpoints, …) provides considerable advantages.

I have looked at several IDEs and the one I keep coming back to for either PHP or Javascript programming is NetBeans.  When you integrate XDebug with Netbeans, you have a solid IDE and Debugger combination.

As at the time of writing this document, The current version of each, which these instructions will cover  was:
Netbeans: v13
XDebug: v3.14

I install NetBeans on my PC and configure it to work as a remote client with a Debian (v10=Buster) linux server configured with Apache, PHP and XDebug.  That way, I keep the server minimally configured, with no desktop software, which increases performance and security for the linux server.  In my case, I have the PC and the linux server on the same network so I do not have to worry about router access or firewall settings, but if you are doing this with the PC and linux servers on different networks, you will have to adapt to suit.

The sequence used to install and configure this setup is:
1. Install XDebug on the linux server
a. Configure XDebug to work with Netbeans on the PC
2. Install Netbeans on the PC
a. Configure Netbeans to work with XDebug on the linux server
3. Create (or import) a PHP project
a. The setup will be done using Netbeans on the PC
b. Project files (scripts) will be stored on the PC (as an archive) 
and the linux server (as the operating entity)
4. Temporarily disable Output Buffering to allow the Debugger to show partial progress
a. At a server level
b. In a script - to get around buffering by the browser

Install and configure XDebug on the linux server
Additional documentation, if desired, for installing and configuring XDebug can be found at:
https://xdebug.org/install.php#configure-php 
with additional documentation at
A list of all settings:  https://xdebug.org/docs-settings.php
A list of all functions: https://xdebug.org/docs-functions.php
Profiling instructions:  https://xdebug.org/docs-profiling2.php
Remote debugging:        https://xdebug.org/docs-debugger.php
Step Debugging: https://xdebug.org/docs/step_debug
And a configuration wizard (if you want to do a manual XDebug installation) at
https://xdebug.org/wizard
The normal way to install any libraries on Debian is to use "apt install …" but if you use that for XDebug, you will end up with an older, deprecated version of XDebug - version 2.7 - for which support has ended and functionality is limited compared to version 3.x .
It is better and just as easy to use the dedicated PHP package manager PECL to install XDebug, and by doing so you get the current stable version, which, at the time of this document was 3.14.  PHP has numerous package repositories, one of which is PEAR (PHP Extension and Application Repository), containing additional modules written in PHP and adhering to a coding standard to ensure quality and maintainability.  Pear modules can be easily installed like any other libraries.  PECL (PHP Extension Community Library) is a subset of PEAR containing a repository of C extensions for PHP. Those extensions are usually installed via the pecl command, which is an alias to PEAR, with the default channel/repository set to pecl.php.net.  C libraries must be configured, compiled and installed for the each installation.  By installing PHP C libraries via PECL, the background tasks for configuring and compiling are all done for you.
To enable pecl commands to work, you must install the developer tools that allow compiling C code.
So, in addition to installing php:
apt install php (done by itself first)
and standard modules required for integration between PHP and a MySQL database
apt install php-mysql libapache2-mod-php
and additional modules, depending on your configuration needs
apt install php-gd php-curl php-mbstring php-xml php-dom php-intl
apt install php-cli php-zip unzip wget
apt install libc-client2007e libzip4 mlock php-imap php-zip php-imap
a2enmod php7.3  
(php 7.3 was the PHP version installed for Debian 10; 
 test with php -v to see which version is on your server)
Install the developer tools and the PECL installer
apt install php-dev 
apt install php-pear (likely already installed on Debian 10 when php 7.3 was installed)
Then use pecl to install the XDebug libraries
pecl install xdebug
(This will take some time since it is actually compiling and configuring for your installation)

At the end of the pecl installation of XDebug, it will tell you to add "extension=xdebug.so" to php.ini.  Do NOT do this.  Follow the instructions below instead.

If they do not already exist, create the following file and softlink to add additional php.ini configurations for XDebug.  My php version is 7.3; adapt your settings to suit your setup.
Create a file 
nano /etc/php/7.3/mods-available/xdebug.ini
zend_extension=xdebug
xdebug.mode=debug
xdebug.client_host={IP_Address_Of_The_PC_Running_Netbeans}
xdebug.client_port=9003
xdebug.idekey="netbeans-xdebug"
Note that as an alternative to setting
 xdebug.client_host={IP_Address_Of_The_PC_Running_Netbeans} 
you could use
xdebug.discover_client_host=1
which would have XDebug auto-configure itself to use the remote PC system as a client when Netbeans makes the connection, but I prefer to manually set the {IP_Address_Of_The_PC_Running_Netbeans} to prevent anyone else from accessing the development environment with XDebug.
Create a softlink to this file, using a high number prefix (99) to ensure that it loads AFTER Zend OPcache.  
Depending on how a PHP script is called, it will use a different php.ini configuration.  
If you call PHP from the Command Line Interface (CLI = Terminal) the php.ini file used and the additional modules / extensions loaded will be determined by the setup in (for PHP v 7.3)
/etc/php/7.3/cli
If you call PHP from the Apache server (using a browser) the php.ini file used and the additional modules / extensions loaded will be determined by the setup in  (for PHP v 7.3)
/etc/php/7.3/apache2
Therefore, to have XDebug available for use when called from the CLI and from Apache, you need to activate it for both.  Do this by putting a softlink to the Xdebug configuration file created above in each of the above two configurations.
ln -s /etc/php/7.3/mods-available/xdebug.ini /etc/php/7.3/cli/conf.d/99-xdebug.ini
ln -s /etc/php/7.3/mods-available/xdebug.ini /etc/php/7.3/apache2/conf.d/99-xdebug.ini
Restart Apache to load the new configuration
systemctl restart apache2

You can now view your installation status using different methods
From your CLI: php -v 
which will return the following (I have PHP v 7.3 installed), showing that XDebug is installed and available when called from the CLI as is Zend OPcache
PHP 7.3.31-1~deb10u1 (cli) (built: Oct 24 2021 15:18:08) ( NTS )
Copyright (c) 1997-2018 The PHP Group
Zend Engine v3.3.31, Copyright (c) 1998-2018 Zend Technologies
    with Zend OPcache v7.3.31-1~deb10u1, Copyright (c) 1999-2018, by Zend Technologies
    with Xdebug v3.1.4, Copyright (c) 2002-2022, by Derick Rethans
From your CLI: php -m
Which will list all the modules loaded when PHP is called from the CLI
From your CLI: php --ini
which will list all the files php is reading to create the full php.ini file when called from the CLI
This will show that the file at /etc/php/7.3/cli/conf.d/99-xdebug.ini is being read.
From your browser, view the XDebug configuration settings
Install on your server a browser-accessible file with the following content
nano /var/www/html/xdebug_info.php
<?php echo xdebug_info(); ?>
View the output of that file by pointing your browser to 
http://{IP_Address_of_Linux_Server}/xdebug_info.php
This will show you the full XDebug configuration used when PHP is called from the Apache server, indicating that you have step-through debugging configured
From your browser, view the full PHP configuration settings when PHP is called from the Apache server
Install on your server a browser-accessible file with the following content
nano /var/www/html/php_info.php
<?php echo php_info(); ?>
View the output of that file by pointing your browser to 
http://{IP_Address_of_Linux_Server}/php_info.php
This will show you the full PHP configuration, including the XDebug configuration settings (same as above) indicating that you have XDebug installed and configured to work with Zend and support step debugging

Install and configure Netbeans on the PC to access and use XDebug on the linux server
Install the Java Development Kit required for Netbeans to operate
Go to https://www.oracle.com/java/technologies/downloads 
With Netbeans 13, the most current Long-Term_Support (LTS) version of the Java Development Kit (JDK) is version 17.  It works well with Netbeans 13.  JDK v18 has issues with Netbeans 13.  Select the v17 tab, then the Windows tab, and download the Windows 64-bit installer from
https://download.oracle.com/java/17/latest/jdk-17_windows-x64_bin.exe
There is a hashtag for the file you can use to check the integrity of the download.
Install JDKv17 onto the PC that will be running Netbeans using the executable you just downloaded
Install Netbeans onto your PC
Go to https://netbeans.apache.org/download/index.html to get the most current version of Netbeans.
I used Netbeans 13 and know it works accourding to these instructions, so in case the above is updated to provide a version newer than v13, you can always click on the "Find out more" button under the "Older Releases" heading on the above page which will take you to https://netbeans.apache.org/download/archive/index.html to get an archived v13 of Netbeans.  Either way, you will download the Windows 4-bit executable from https://www.apache.org/dyn/closer.cgi/netbeans/netbeans-installers/13/Apache-NetBeans-13-bin-windows-x64.exe 
Run the installer on your PC
Bug Fix
There is a long-standing bug in Netbeans which can cause the underscore to not display in some editor windows.  This shows, for example, in PHP code when you are defining a function and the function name contains underscores.  To fix this, just change the default font used by Netbeans.  The editor display is most functional when a monospace font is used so I used courier as the replacement default font.
Tools -> Options -> Fonts & Colors -> Syntax (initial tab)
Font: Click the three dots to the right of the field and choose Courier New, Plain, 14
[bookmark: _GoBack]Click OK
Configure Netbeans to use the XDebug libraries on the Linux server
Launch Netbeans
Using the Menu items at the top of the Netbeans window:
Tools -> Options -> PHP -> Debugging (tab)
Debugger Port: 9003
Session ID: netbeans-xdebug
Maximum Data Length: 2048
There are additional options shown on that page that you can choose as you wish.  
If you are going to be using breakpoints in your code (likely yes), then:
Stop at First Line: Uncheck
Resolve Breakpoints: Check
If you are just debugging one file and just want to step through that one file, then 
Stop at First Line: Check

Create a PHP project in Netbeans
To create a project using a remote linux server as the host, tell Netbeans:
Where the files are to be archived on your PC
Where on the linux server your web files will be located
The instructions below will show how to create a new project when you already have a web site you wish to use Netbeans to edit.  You still start with "New Project" in order to create the archive files on your PC, but you then Download the current files from your linux server to load your project with content.
What configuration you will be using to exchange files between yourself and the linux server (SFTP recommended)
Launch Netbeans on your PC 
File -> New Project
Step 1 - Choose Project
Filter: {leave blank}
Categories: PHP
Projects: PHP Application from Remote Server
Note that if you were creating a New Project from scratch, you would select "PHP Application" and your Step 3 would then be "Run Configuration" where you would be asked to specify "Run As", where you would select "Remote Web Site" and then proceed as shown below in Step 3.
Click Next
Step 2 - Name and Location
Project Name: {Open Text Name of Project - Spaces are Allowed}
Sources Folder: {Location on your PC where the project files will be archived}
PHP Version: 7.3 (select what is correct for the PHP version on your linux system)
Default Encoding: UTF-8 (almost always the encoding for English-language projects)
Put Netbeans metadata into a separate directory: {Leave Unchecked}
You can Check this and specify a distinct directory on your PC to store the kind of information Netbeans needs to work with the Project, but this is usually not done.  Normally, you just have the metadata stored on your PC in the same archive folder as the Source code.  The metadata is NOT uploaded to the linux server; it is just used on the PC.  If it is Checked, make sure to match this for the setting of Project Folder in the Project Properties.  Normally, if this is NOT checked, the Project Folder (containing the metadata files) and the Source Folder (containing the web site files) are the same, but if you have checked this, they will need to be different.
Step 3 - Remote Connection
Project URL: The full URL, including http(s)://{FQDN = IP or domain.tld}
Remote Connection:
You can share a remote connection between multiple projects on the same server or declare a unique connection for each project
The remote connection identifies a root directory for the linux server's web server and you (later in the setup) have an opportunity to then declare a path to each project's specific directory.
If you are sharing a Remote Connection with a previously defined setup, just select the previously defined setup from the dropdown choices.  Check the previously defined setup to make sure you know what was defined as the root directory and then you can declare the relative path from there to the directory containing this project's files.
If you are creating a new Remote Connection, click "Manage" to the right of the dropdown directory for Remote Connection:
Name: {Pen text Name - spaces allowed}
Host Name: {IP address / FQDN of linux server}
Port: {Port used for file transfer: usually 22 for SFTP}
Username: {Username for an authenticated user of the SFTP server on the linux server}
Password: {Matching Password for an authenticated user of the SFTP server on the linux server}
Private Key File: (Only used if using key-pair authentication.)
Known Hosts File: 
You want to create a file on your PC (likely at the root level of your Netbeans Archive directory) to hold your "Known Hosts File" and then browse to that file using the Browse button to the right of the Known Hosts File: field.  If you do not do this, every time you make a connection to a remote server, you will be challenged to present a certificate.  With this file in place, the first time you make the connection, it will store the linux server identification in the "Known Hosts File" and you will not be challenged again.
Initial Directory:
If you plan to re-use this Remote Connection for multiple projects, point this to the absolute path to the root directory of the web server on the linux server.
If you plan to have this as a dedicated Remote Connection for only this project, you could either point this to the root directory and then use the project setup to declare the relative path to the project or just point this directly to the absolute path to the project.
Timeouts (s): {Leave as is or enter the number of seconds you want}
Keep Alive Interval (s): {Leave as is or enter the number of seconds you want}
Click "Test Connection" to ensure the parameters work
Click "OK"
Upload Directory: {The relative URL to the Project files from the root directory given in the Remote Connection specified above}
Step 4 - Confirmation
You will be presented with a screen that asks you which of the files at the location specified on the linux web server (for this project) you wish to download to your PC archive.  The default is "Check All" and would be what you would normally do.
Click Finish
Final Configuration
You will now have the project listed in the left column of the Netbeans user interface (assuming you have "Projects" tab selected for the left column).
Right-click on the project name and select Properties
Click Advanced
For the "Debug URL", I like to use "Ask Every Time", but if you are always starting at the root index file of your project, you can select the "Default" option.
You do NOT need to make any entries in the "Debugger Proxy: Host" and you do NOT need to worry about the "Debugger Proxy: Port" setting here.
Temporarily disable Output Buffering to allow the Debugger to show partial progress
The above setup may not seem to work when you try to use step through for your script since the output shown on your web browser does not immediately reflect the output of the program at the point your program shows it producing an output.  This is because your server (and most current browsers) try to be more efficient by holding I memory (buffering) the output until there is enough to make it worthwhile or until the program completes, whichever comes first.
But in our case, we want every line of code to show its output when there is output, regardless of how small the output is and regardless of whether the program has completed.
To do this you must (TEMPORARILY) disable output_buffering by both PHP and the browser.
MAKE SURE to re-enable output_buffering when you are finished development and debugging or your script will be inefficient.
To disable PHP-level output buffering, you can either:
Disable it at the server level
Disable it at the script level
To disable the output buffering by the browser, you need to use the script-level disabling technique.
To disable output_buffering at the server level:
Create a new file
nano /etc/php/7.3/mods-available/50-output_buffering.ini
output_buffering=Off
Create a symlink to that file
ln -s /etc/php/7.3/mods-available/05-output_buffering.ini /etc/php/7.3/apache2/conf.d/50-output_buffering.ini
Restart the apache server to load the new configuration
systemctl restart apache2
To disable output buffering at the script level:
In the index.php file that is the initial file for the web site, add, at the TOP of the file
<?php
ob_end_clean(); // disable output buffer
ob_implicit_flush(); // call flush() automatically after every output
